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Introduction

This workshop is essentially the same as ArcMap Introduction, except compressed into one
quick and dirty hands-on session. It is designed for those with ‘more than basic’ computing
skills, limited time, or those wanting a fast-paced experience with spatial data and software.
Participants may also be interested in attending: GIS I: Finding GIS Data on the Web and GIS II:
Mapping Your Data.

Objectives
* Add and remove data in ArcMap * Save work as map document
* Navigate (zoom, pan, etc.) * Set view projection
. Iaearn about format of geographic * Set display/ distance units
ata

e Measure distances

* Turn layers off and on e Select a record from the attribute

* Change layer order table, manually and by performing a

* Display data by particular attributes query

* Select features by location/
relationship to features in other

* Use Identify tool layers

e Label features

More Information

All workshops offered through Information Services are free to KU students, staff, faculty, and
approved affiliates. To learn more about or register for workshops, receive announcements of
upcoming workshops, and track workshops you attend, visit the KU Libraries Instruction Web
site at www.lib.ku.edu/instruction.

Upcoming GIS Workshops (: http://www2.ku.edu/~workshops)
0 GISI: Empower Hour, Aug. 21
o0 GIS I: Finding GIS Data on the Web, Aug. 23, Oct. 26
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o GIS Il: Mapping Your Data, Aug. 25, Oct. 31

The datasets that accompany ArcGIS, or ‘ESRI Data and Maps’ are now available online at
http://qgis.lib.ku.edu/esri_data_maps.shtml. The PDF software manuals, or ‘ESRI Digital Books’
are also available via the Web at http://qgis.lib.ku.edu/esri_dig books.shtml.

Additional Help

Online Tutorials- Learn GIS at your own pace through virtual tutorials. ESRI online tutorials are
available free to KU-affiliates and can be used by individuals or classes. See a list of courses at:
www.kars.ku.edu/user/vc_courses.shtml and email or call (data@ku.edu, mickey@ku.edu or
864-1238, 864-0454) to register for one or more.

GIS and Data Lab - 105 Anschutz Library
Hours (while KU is in session): Mon-Thurs 9AM-8PM, Fri 9AM-5PM, Sat/Sun 1PM-5PM
Contact: data@ku.edu or 864-1238 (Rhonda Houser), 864-7777 (Mickey Waxman)

More information: www.lib.ku.edu/qgis

Copy Workshop Data

* To copy workshop data from network drive to hard drive, click on Start (button) = Programs
- ArcGIS - Data

* Click once on the folder called gis1
* Under File and Folder Tasks, choose ‘Copy this folder’
* Make sure c:\ wutemp is selected as file destination

* Click on ‘Copy’

Explore ArcMap
* Click on Start Menu = Programs - ArcGIS 2> ArcMap

ArcGIS is a suite of software that includes ‘ & ‘ArcCatang, ‘ Q ArcMap, and 3
ArcToolbox, among other modules. ArcCatalog is for data management; ArcMap is primarily
for displaying and working with data, and ArcToolbox is for data conversion and manipulation.

* Click OK to start in ArcMap with a new empty map (if message appears)

* Maximize ArcMap (click on 18] middle button, top right corner)

* Find your toolbar J@Q“ "é"’?OﬁQL\EROM&f‘

Add Aerial Photos (below) OR use Orthophotos via IMS (jump to bottom pg. 4)
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. + . .
* Click on the ‘Add Data’ button ‘ ' to bring data layers into ArcMap
* Navigate to: c:\ wutemp\ gisl

* Hold down the Ctrl key while clicking on (selecting) each of the following aerial photos
(raster datasets) to add them all at once: 121925.sid, 121936.sid, 122030.sid, 122031.sid

* Click on ‘Add’
* Click 'OK’ for any messages that appear about building pyramids or about spatial reference
* Double-click on the photo name in the table of contents

* Click on the Source tab, and scroll down to note the lack of coordinate system information.
The photo may be in a particular geographic projection or coordinate system, but this
reference information was not recorded in the dataset, and so does not appear on the
Source tab.

* Click Cancel
* Click on ‘Full Extent’ button L to see entire area covered by the air photos

e Click on the ‘Precise Zoom In’ tool F@ then click, hold and drag a box around an area on
the map that you want to see closer

* To deactivate current tool being used or switch to another tool, click on the Select Elements

button W (default tool or cursor) or click on another tool

. . |
* Click on the ‘Previous Extent’ button s to return to the last zoom
* Find Jayhawk Boulevard, Strong Hall, South Park, or where you work or live on campus

* Click on the ‘Window’ menu and choose ‘Magnifier’ to bring up a magnification window
* Move the window by clicking/ dragging the top blue bar

* To change magnification level, right-click on the blue bar and choose ‘Properties’

* Close the ‘Magnifier’ window

* Turn one air photo on or off by clicking in the box next to the layer title (to remove
checkmark)

e Turn all layers on (make them draw)

OR Add orthophotos through an IMS
You can also use orthophotos through an internet mapping
service (IMS). An IMS allows you to use data via the web,
instead of downloading and using from your computer. The KS
GIS clearinghouse, or DASC, makes imagery and raster data
available through IMSs at:
http://www.kansasgis.org/catalog/catalog.cfm. For the 2002 l,.r L
County Orthophotos, directions are provided for connecting to [j‘é | @[Refresh view|
the IMS.
* In ArcCatalog’s left-hand listing of drives/folders, click on the plus sign to select GIS
Servers, then select Add ArcIMS Server

"]
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* Copy the data server URL (http://maps.kansasgis.org) into the box provided

* Expand maps.kansasgis.org and scroll down to the kgcc_Imagery map service

* Drag it into ArcMap to the left-hand listing of layers (table of contents)

* In ArcMap, expand this layer and check the boxes next to ‘kgcc_Imagery’ and ‘View Aerials
2002’

* Hit the Refresh button at bottom (chasing arrows) if imagery does not draw or only partially
displays.

Add Vector Data

* Click on the ‘Add Data’ button ‘ Y to bring in more layers (you can also right-click
anywhere in the mapping view to add data)
* Navigate to: c:\ wutemp\ gisl
* Select the vector layer for schools (represented by points): LawrenceSchools.shp
* Click on ‘Add’
* Right-click on layer title and choose ‘Zoom to Layer’
* Turn this layer on if needed
* Repeat this process to add and look at the following layers:
BikePaths.shp (bike paths represented by lines)
NeighAssn.shp (neighborhood associations represented by polygons)
Parks.shp (parks represented by polygons)

Streets.shp (streets represented by lines)

Data are layered one on top of the other in the view (stacked out toward you), according to their
order in table of contents (left-hand listing of data layers). Most recent layers added will be on
top, with point layers over line layers and line layers over polygon layers. Change layer order by
clicking and dragging a layer on top or below another in the table of contents.

¥,

* Click on the ‘Pan’ tool then click, hold and drag map to move (or use scroll bars)

* Click on ‘ldentify’ tool [6 This tool brings up associated attribute information for a feature
(point, line or polygon) that you click on. By default, information is shown for the top
layer.

* Choose parks as the target layer and click inside one to see table information.
* Close the ‘Identify’ tool window.

* Remove neighborhood association layer: right-click on layer title and choose ‘Remove’

(this does not delete data from hard disk) = e Ty -
. Be s poss
* Add layer back in N
(™ ] L. fo
E i a
r CITYPARK_| CITYPARK_| PARKNAME CLASSIF|
*7} » 21 4 community
"i‘f—‘: N - 2_ 1/|Riverfront Park »community
v | 3_ 2|Maple Grove Cemetery |cemetery
[ 4 250 future park (undeveloped|future
‘.f‘ 5 1/ future park (undeveloped| future
\ 6 1|Martin Park community
L-‘J 7 1/ future park [undeveloped | future
8 1/ future park [undeveloped | future
L 9_ 1|Burcham Park _community
n 11 hhe nark liindeseloned| fibire

|

e 1
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* Right-click on parks layer to select, and choose ‘Open Attribute Table’ to view tabular data

* Close the parks attribute table

* Click on ‘Full Extent’ button L to see total area covered by data layers

Change How Data Display

ArcMap applies a default display scheme to data layers (i.e. the colors, classes and patterns

used to display data). These settings are dynamic and can be changed so that data are

displayed using the information in the attribute table or with a certain color, line thickness, or

particular symbol.

e Turn off (uncheck box for) every other vector layer except the one being edited below so
changes are apparent. Leave aerial photos (raster data) on as a base map.

Schools, Streets and Neighborhood Layers

* Zoom to the extent of the schools layer (right-click)

* Double-click on the title (next to check box) of this layer in the table of contents, to bring up
the ‘Layer Properties’ window

* Click on each tab in turn to see properties and information provided

* Onthe Symbology tab, click on the box near ‘Symbol’

* Select ‘Features’ and ‘Single Symbol’

* Select one of the formatted symbols or create a custom symbol under ‘Options’

* Click OK and OK again

* Repeat this process for Streets and Neighborhood Associations

Label Streets
* Right-click on the streets layer title and choose ‘Label features’ (field used for labels can
be changed in properties, on the Labels tab)

K
AK

* Click on ‘Fixed Zoom In’ tool to zoom in (closer) at regular intervals and notice what
happens to street names as you zoom closer?

* Turn labels off (right-click on layer) if they are slow to draw

Bike Paths and Park Layers

* Zoom to the extent of the Parks layer (right-click)

* Double-click on the title (next to check box) of this layer in the table of contents, to bring up
the ‘Layer Properties’ window

* Click on each tab in turn to see properties and information provided

* Onthe Symbology tab, select ‘Categories’ and ‘Unique Values’

e Under ‘Value Field, choose ‘CLASSIFICATION’ and click ‘Add All Values’

* Change color scheme or individual colors (by clicking on each symbol)

* Click OK

* Repeat this process for Bike Paths, using the ‘STATUS' field

* Go back to properties for Parks

* Click on the Display tab and change the percent transparent value (40-60%), so you can
see underlying air photos
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* Click OK

Save Settings and Data as One File
* Choose File > Save As and save map document in c:\wutemp

You can save existing data, settings, display schemes, etc. as ONE file. Map document files
end with .mxd and do not store actual data layers, but references to those layers and settings
for data and the data frame.

* As you work, choose File & Save to save changes

Compare View Projections

* Choose View 2> Data Frame Properties (or right-click in the View)

* Click on the Coordinate System tab and in the ‘Select a Coordinate System’ box choose:

Predefined = Projected Coordinate Systems - State Plane > NAD 1983 (feet)
NAD 1983 StatePlane Kansas North FIPS 1501 (Feet)

* Click OK

* Choose View - Data Frame Properties again

* On the General tab, change Display Units to Meters
* Click OK

* Find and zoom into Burcham Park (near the river)

i
* Click on the ’:—"‘- Measure Tool to measure the west (left) perimeter of this park from SW to
NW side gy %

* Click and drag to start measuring; double-click to stop

* Distance is simultaneously displayed at the bottom left of the data
frame

* Write down the total distance m (State Plane)

* Choose View > Data Frame Properties

* Onthe Coordinate System tab, in the ‘Select a Coordinate System’
box choose:

* Predefined = Projected Coordinate Systems - UTM - NAD 1983
- NAD 1983 UTM Zone 14N

* Click OK

e Zoom into Burcham Park again if necessary
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* Use the Measure Tool again to measure the same side of the park
* Write down the total distance m (UTM)
Projections affect distance, area, direction or shape (or a combination of these). Depending

on the scope and scale of a dataset or project and level of accuracy required, using different
projections might clearly make a difference in distance (or other parameters).

How wide is the Kansas River at the downtown bridge?
How long is the path that loops around the ‘Train Park’ at 6™ and Kentucky streets?

What is the real name of this park? (use [6 Identify tool)

* Change the projection back to Kansas State Plane North by following the directions at the
beginning of this section

Find ‘community’ parks

* Choose Selection - Clear Selected Features to clear any previously highlighted features
* Open the attribute table of the Parks layer (right-click on layer)

* Hit the ‘Options’ button and choose ‘Select by Attributes’

* Use the ‘Create a new selection’ method

* Double-click on field name (CLASSIFICATION); Single-click on operator (=)

* Click ‘Get Unigue Value’ button to display values from the table

* Double-click on field value (community) to complete the equation: "CLASSIFICATION" =
‘community’

* Click on ‘Apply’ and ‘Close’ to see selected parks

Community parks are highlighted in the table (note number of records selected at bottom)
* Close the table to see the community parks highlighted

* Clear selected features (parks); choose Selection - Clear Selected Features

Create new layer for public schools

* Now use the same methodology to determine how many private schools are in Lawrence,
and where they are. Use the Schools layer and select by attribute from the Selection menu
in the mapping (not table) view.

* All private schools should now be selected (highlighted); open the attribute table, click the
‘Options’ button and choose ‘Switch Selection’ to highlight public schools

¢ Close the table

* Right-click on the schools layer and choose Data = Export Data
* Export selected features using the same coordinate system as the layer’s source data
and save in c:\temp
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Choose Yes to add the new layer, and check the table to confirm it contains only public
schools

Find parks in Oread neighborhood

Label neighborhood associations

Turn off all layers except neighborhoods and parks
Drag the parks layer above the neighborhoods layer so it displays on top

To set the field (or column heading from attribute table) used to label features, double-click
on the neighborhood layer title to bring up ‘Layer Properties’

Click on Labels tab and choose LABEL in the drop-down box for Label Field
Click OK

Right click on the neighborhood layer title and choose Label Features

Highlight ‘Oread’ neighborhood

Right-click on neighborhood layer and choose ‘Open Attribute Table’

Right-click on the ‘neighborhood’ column name and choose ‘Sort Ascending’ to alphabetize
names

Select ‘Oread..’ by clicking on the arrow at the far left of this record with the Pointer tool IT
Close the table o .

Zoom in to the Oread neighborhood; right-click on layer and choose
Selection > Zoom to Selected Features E

Choose Selection = Select by Location (select by relationship to
features in other layers)

Oread

Complete the phrase:

| want to: select features from

the following layers: Parks

that: are completely within

the features in this layer: NeighAssn

Make sure the boxes are checked next to ‘Use selected features’

Hit Apply and Close

versity Place

Go through the ‘Select by Location’ process again to find out how —
many and which parks are within a quarter-mile of the Oread NA (choose ‘add to
currently selected features’ in first dropdown window) to find additional parks
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T 21

Lets you select features from one or more layers based on where they are located
in relation to the features in another layer.

| want to:
Iadd to the currently selected features in 3
the following layer(s):

[] Streets |
V| Parks
[] Neighdissn z‘

™ Only show selectable layers in this list
that:

Iare within a distance of ZI
the features in this layer:
I Neigh&issn L]
IV Use selected features (1 features selected)
IV Apply a buffer to the features in Neigh&ssn

of: [0.25 [Miles |
i~ Preview

The red features represent the features in Neigh&ssn.
The highlighted cyan features are selected because they
are within a distance of the red features.

Points Lines Polygons

Apply I Close I

Note: Please complete a workshop evaluation. An online evaluation
is linked from the internet browser ‘Favorites’ menu.
Definitions
Term Definition
. system comprised of spatial data and software in which user can display
geographic . . . .
nformation and manipulate layers of information representing real world features and

systems (GIS)

their actual geographic location.

latitude and
longitude

spherical reference system used to measure locations on Earth's surface;
latitude measures angles in a north-south direction; longitude measures
angles in the east-west direction (from www.esri.com).

map projections

describe ways to represent areas on the Earth’s surface (three-
dimensional) on a flat surface such as a map; imagine trying to wrap a
piece of paper around a globe; all projections distort shape, area,
distance or direction to some extent.

map scale

dimensions of a map compared to the dimensions of the Earth, usually
expressed as a ratio between a distance on the map and a distance on
the Earth; for instance, a scale of 1:24,000 means 1 unit of distance on
the map equals 24,000 units on the ground.

10
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pyramids

give original data several levels of resolution to speed display of large
raster data files; a lower resolution copy of the data displays quickly when
drawing the entire dataset; levels with finer resolutions draw as user
zooms closer (www.esri.com).

raster

type of spatial data in which features are represented by cells (or pixels)
with same value and cells are organized in a grid of rows and columns;
raster format is appropriate for data that vary continuously over space
such as elevation; images and grids are types of raster data.

vector

type of spatial data in which features are represented by points, lines or
polygons; coordinate-based structure (XY or latitude-longitude)
commonly used to represent linear features; coverages and shapefiles
are types of vector data.

Last Update: 09/07/2006
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